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Introduction

1 Introduction

Learn how to import, re-analyze, and then explore the XaoS example report included in
Streamline. The report was generated running the XaoS example included in Arm
Development Studio (Arm DS).

We use one of the example reports that are included with Streamline. These reports provide a
quick way of exploring the features of the Streamline performance analyzer. The sample
report used in this tutorial was captured by running the XaoS example included in Arm DS on a
Cortex-A7 and Cortex-A15 Versatile Express board.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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2 Import the Linux example project

The sample Streamline XaoS report was generated using the XaoS example project in Arm DS.
Therefore, to work with the report, you must import the Arm DS XaoS example project to your
Arm DS Workspace. To import the XaoS example project:

1. OpenArm DS IDE.
2. Click File > Import.

3. Inthe Import window, expand Arm Development Studio and select Examples &
Programming Libraries. Click Next.

* Import a

Select

Imports the Arm Development Studio examples to the current workspace

Select an import wizard:

type filter text

> = General

v = Arm Development Studio
© Examples & Programming Libraries
uVision Project

> &C/C++

> & Git

> & Install

> = Remote Systems

> & Run/Debug

@ < Back | Next > | Finish Cancel

4. Inthe Import Examples and Programming Libraries window, expand Examples > Linux
Applications and select xaos. You can also write "xaos" in the search bar to locate the
example project. Click Finish.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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* Import Examples and Programming Libraries O

Import Development Studio Examples and Programming Libraries %é )

% Some projects cannot be imported because they already exist in the workspace or in workspace
directory

’ Xaos

v [m] Examples
v [m] Linux Applications

Xaos

Description
This example illustrates Streamline performance analysis, including annotation, using the example "Xaos"
application.

Working sets

og

O B

[_] Add project to working sets New...
Working sets Select...
@ < Back Next > | Finish Cancel

5. The xaos example project now appears in the Project Explorer view.

What is XaoS?:
XaoS is an open-source "interactive fractal zoomer" application. In our case, it runs multi-
threaded to generate an interesting report.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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3 Import Streamline example report

Streamline is included with Arm DS installation. Now open Streamline. You will see the
following IDE:

Streamline - Arm Development Studio Gold Edition
File Edit Streamline Window Help
 Streamline Data| 4 Capture Control ~ 9% start =

& & 8| Filter [% & ea

Bare-Metal - AS - RTX Traffic Lights Entertarget deais

*» Barman - AS - RTX Traffic Lights

* Barman - A9 - RTX5 Blinky

*» Barman - AArch64

*» Barman - M3 - mcbstm32e
* Barman - M33 - RTXS5 Blinky
* Barman - R5

* Linux - Annotations

No targets have been detected. Please refer to the gator_me py instructions, o the Android or Linus target setup guide.

I > Linux - Arm DS Annotate Example
> Linux - Arm DS Cache Test Example
> Linux - TC2 - Xaos

| > RTXv4_Streamline_bare_metal example 2

ADB tool path was not configured and cannot be detected. Set the location of the tool: ADB Location

Configure Appication

Opionally, enter the command you wish to run

Command: | Ente

Working Directory: | (Opt

User Name: | (Opti

9 stopon exit

© Console & ICRA=-RaGE

No consoles to dispay at thi time. _

Now, you must import the XaoS Streamline example report. To import the example reports:

1. Click File > Import...

2. Select Import Streamline Sample Captures and click Next.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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Import O X

Select lﬁ

Select an import wizard:

type filter text

ea Import Capture
i Import Streamline Sample Captures

< Back | Next > | Finish Cancel

3. Youcan now select the sample Streamline captures available that you want to import.
For this tutorial, select the Linux > Arm DS Xaos Example. To import the sample
capture, click Finish.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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O X

Import Sample Captures

Select the sample captures to import from the list below:

v [v] Linux
Annotations Examples
Arm DS Annotate Example
Arm DS Cache Test Example
Arm DS Xaos Example
v [] Bare-Metal
Bare-Metal Agent Example running on Armv8 model
RTXv4 Traffic Lights Example running on Cortex-A5
Bare-Metal Agent Example running on Cortex-R5 model
Bare-Metal Agent Example running on Cortex-M3 on MCBSTM32E board
Bare-Metal Agent Example Blinky running on Cortex A9
Bare-Metal Agent Example Blinky running on Cortex-M33
v [V] Instruction Trace
RTXv4 Traffic Lights Example running on Cortex-A5

< Back Next > Finish Cancel

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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4 Re-analyze the report

The Linux- TC2 - Xaos capture is listed in the Streamline Data view. Notice that the vertical bar
at the left of the capture (in the list of captures) is yellow, meaning it must be re-analyzed.
Streamline - Arm Development Studio Gold Edition

File Edit Streamline Window Help

&4 Streamline Data % Capture Control‘ ~ O\ % Start

S EE l Filter IX (ERZ Tl Select Target

I *» xaos-multithreaded-VE-A15x2-A7x3

Enter target details:

*> Bare-Metal - A5 - RTX Traffic Lights Enter the target address in the form <hostname>, <hostname>:<port>, or adb:<serial-number>
*» Barman - A5 - RTX Traffic Lights Or, choose an existing target:

.
> Barman - A9 - RTX5 Blinky

> Barman - AArch64

> Barman - M3 - mcbstm32e
> Barman - M33 - RTX5 Blinky
> Barman - R5

No targets have been detected. Please refer to the gator
* Linux - Annotations

I * Linux - Arm DS Annotate Example

* Linux - Arm DS Cache Test Example

Linux - TC2 - Xaos
14 May 2020, 17:05:48

Streamline v7.3
V2P-CA15_CA7 - 10.2.201.23
C:\User-\Documents\Streamline

Configure Application

> RTXv4_Streamline_bare_metal_example_2
Optionally, enter the command you wish to run:

Command: | Enter the command and any arguments
Working Directory: | (Optional) Enter a working directory for the command

User Name: | (Optional) Enter username to run the command as. Requires root permissions.

B Console = M8 yOvy =0

Configure Capture

T —

No consoles to display at this time.

Why do | have to re-analyze the report?:

Since the report was generated with a different version of Arm DS, you must re-analyze it into
update it.

In the Analyze dialog box, you can load extra program images. These images can be useful for
gaining a more comprehensive idea of system execution, or alternatively, for focusing on one
particular program. Streamline loads debug symbols if available.

To open the Analyze dialog, double-click on the Streamline capture. In the Program Images tab,
select the ELF images xaos and libpthread-2.17.so. Thenclick Analyze. Re-analyzing the
capture might take some time.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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Linux - TC2 - Xaos
Analyze

Choose the settings to produce a new report.

NA

Version 0.0
Re-analyze the report

X

Analysis

Process Extra Debug Information (when available)

Resolution mode: Normal v

Program Images‘Script Search Paths’

B O & Add ELF image... B Select Separate Debug Image.

. X Remove
Use Name Symbols Debug Info CFI Remarks
M & xaos v v v
M & libpthread-2.17.s0 v B

Debug data in separate files

Analyze | ’

Cancel
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5 Exploring the sample report

The XaoS report opens in a new tab automatically once you have re-analyzed it. It provides a
summary view of CPU performance, branch mispredictions, memory and cache accesses, along
with a sample of the frame buffer. Note that the vertical bar of the capture is now colored blue
in the Streamline Data view, meaning it is up to date.

Streamline - Arm Development Studio Gold Edition - b4
File Edit Streamline Window Help
% Streamline Data % Capture Control = B ||% Start | & Linux - TC2 - Xaos el
& elfter % 14 s | @ Timeline| # Call Paths| ® Functions| i Code|# Log
| > sa0s-multithreaded-VE-A1512-AT3 R n vv e @ isoms - 2107835 My
* Bare-Metal - A5 - RTX Traffic Lights 0E ‘‘‘‘‘ 0 s o 15s L 2s 255 3s 35S 4 455 5s 555 o 6s. 65s  Ts . TS o 8 85s . 95 95 o 1(
Bf AT Gt mA Rt AR A R R ARG AR ARG R ARG RGIIR ﬂiiﬂij

> Barman - A5 - RTX Traffic Lights » CPU Activity (Cortex-A15) e

> Barman - A9 - RTXS Blinky OUser
®System
> Barman - AArch64
> CPU Activity (Cortex-A7) e
> Barman - M3 - mcbstm32e oUser |
> Barman - M33 - RTXS Blinky Sytem i
> Branch (Cortex-A15) i
. .
BSHA SR oMispredicted
> Linux - Annotations
> Linux - Arm DS Annotate Example > Branch (Cortex-A7) i
©Mispredicted
> Linux - Arm DS Cache Test Example
Linux - TC2 - Xaos > Bus (Cortex-A15) aE
107824415 @ 14 May 2020, 17:05:48 s
Streamline v7.3
V2P-CA15_CA7 - 10.2.201.23
1ms Resolution > Cache (Cortex-A15) bl
C\Users\viclab01\Documents\Streamline ©L2 data access
> RTXvd_Streamline_bare_metal_example_2
> Cache (Cortex-A7) i
©L2 data access -
4 idle £
 Console )~ S v =0 kemel ] 55 5 5 5
No consoles to display at this time. # accounts-daemon #2238 | |
# dhclient #2545 1
> gatord #2762 IR INEm II--------I-----
# Ixsession #2356

WHeat Map [H] ¥ Row Filter Annotation Filter CPU Activity ™ &2

In the panel underneath these charts, there is a heatmap for each process and thread. Click
individual processes or threads to reconfigure the charts to reflect them. You can also see
annotations on each thread and the frame buffer, which are being passed from the source code.
These annotations are a very useful profiling tool when you are working on your own code.

Along the top of the report, there are tabs which break down the data all the way to source
code level. When using Streamline to profile your own software, look for areas where the CPU
is being pushed hard, or where the cache is being heavily used. Then, try to identify which line of
code is causing this.

| see numerous <unknown code in "x">inthe Call Paths and Functions tabs :

This issue relates to the images that you use for analysis in the first place. By default, this
capture only includes a couple of images (in this case, the images xaos and 1ibpthread-
2.17.so0).So, while Streamline knows that function "x" is taking up a certain percentage of
processor time, it does not know what this code is.

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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6 Add the missing source code

In the Functions tab, try double-clicking on a function name such as calculate. This action takes
you to the corresponding line of source code. However, the source file is missing.

Streamline - Arm Development Studio Gold Edition - X
File Edit Streamline Window Help .
& Streamline Data| % Capture Control = O || Start| & Linux - TC2 - Xaos = oG

$ | Filter Xeudm

I * xaos-multithreaded-VE-A15x2-A7x3

Timeline | # Call Paths|® Functions ki Code| % Log
a2 X A Je
Self: Samples (#/%)| | |Line Source File: /tmp/plgbuild/abs_build/502866_18431 mpl ivery/wi i i Xa0s-3.5/src/engine/calculate.h

*» Bare-Metal - AS - RTX Traffic Lights
> Barman - AS - RTX Traffic Lights

*» Barman - A9 - RTX5 Blinky

*» Barman - AArch64

* Barman - M3 - mcbstm32e

> Barman - M33 - RTXS Blinky e
* Barman - RS w
* Linux - Annotations

* Linux - Arm DS Annotate Example

* Linux - Arm DS Cache Test Example

Linux - TC2 - Xaos |
107824415 @ 14 May 2020, 17:0548 5 =

Streamline v7.3 Self: Samples (#/%)| 1 |  Address Opcode |Disassembly A
V2P-CA15_CAT - 10220123 calculate

1ms Resolution @X@0048EFC PUSH {r4,r5,ri1,lr}

CAUsers\vidab01\Documents\Streamline ©x00048F00 MoV r4,#ex3cf4

7% 0x00048F04 MOVT A

07% ©x00048F08 ADD rii,sp,#oxc

> RTXv4._Streamline_bare_metal_example_2

1[e.
1 e.
4 0.27% = ©x00048FOC SuB sp,sp,#8
6 0.41%  ©x00048F10 VLDR s3,[rd, #0x70]
1 ©0.07%  ©x00048F14 MoV rs,
2 0.14%  ©0x00048F18 VLDR 515, [r4, #0x6c]
G .S con| 2 0.14%  ©x00048F1C LDR re, [r4,#ex38]
9 Console = s = 3 0.21%  0x@0048F20 VMUL.F32 s2,50,53
No consoles to display at this time. 2 0.14% ©x00048F24 VMUL.F32 s3,s1,s3
0x00048F28 P re,#o
0x00048F2C VMLA.F32 s2,s1,515
©x00048F 30 VMLS.F32 s3,50,515
5 ©.34% = ©0x00048F34 VSTR s2,[rl1,#-0x10] 0
< >

Follow the on-screen hint to Click here to locate the file. You can find the source code for the
XaoS example project in your workspace. You can locate the file in C:\Users\<User>\Development
Studio Workspace\xaos\xaos-3.5\src\engine\calculate.h.

Once you have located the file, the source code appears:

Streamline - Arm Development Studio Gold Edition — X
File Edit Streamline Window Help
1 Streamline Data 4 Capture Control | < B || Start|  Linux - TC2 - Xaos ==
$ @ B| Filter % 4 0u | B Timeline| # Call Paths ® Functions ki Code| % Log

o~ e & [ Find ] 25 (0.05%) | @

I > xaos-multithreaded-VE-A15:x2-A7x3 X
Self: Samples (#/%)| I Li

I e el i L 3 T
> Bare-Metal - AS - RTX Traffic Lights : File: C/Users, / Studio P .5/src/engine/s ~
*» Barman - A5 - RTX Traffic Lights 2 static pixel32_t INLINE
. 3 calculate(number_t x, number_t y, int periodicity) CONSTF;
> Barman - A9 - RTXS Blinky 4 static pixel32_t INLINE calculate(number_t x, number_t y, int periodicity)
6 0.41% 5

> Barman - AArch64 5( pixel32_t i;
c £33

25 1.71% l]  rotateback(cfractalc, x, v);

* Barman - M3 - mcbstm32e

> Barman - M33 - RTXS5 Blinky 2 0.14% 9 if (cfractalc.plane) {
10 recalculate(cfractalc.plane, &x, &y);
*> Barman - RS 1
e —— 12 STAT(ncalculated2++);
13 #ifndef SLOWFUNCPTR
* Linux - Arm DS Annotate Example 10| 0.68% 14 if (cfractalc.mandelbrot) {
i sy DS Cacls Tt Exarile 14| 0.96% 15 if (cformula.flags & STARTZERO)
Li 16 i = cfractalc.calculate[periodicity] (cfractalc.bre,
Linux - TC2 - Xaos 17 cfractalc.bim, x, y); v
2020, 174 1o 2
;‘gzﬁml i3 4/May 2020170348 Self: Samples (#/%)| | | Address Opcode |Disassembly ~
V2P-CA15_CAT7 - 10220123 0x00052988 PUSH {r4,rs,ri1,lr}
ks Rasolition 0x0005298C MoV r4,#ox3cfa
CAUsers\vidlab01\Documents\Streamline ©x000529C0 MovT ré4,#9
©8x000529C4 ADD rili,sp,#exc
* RTXv4_Streamline_bare_metal_example_2 ©x000529C8 suB sp,sp,#8
0x000529CC VLDR $3,[r4,#0x70]
0x000529D0 MoV r5,ro
0x000529D4 VLDR s15,[r4,#0x6c]
0x000529D8 LDR re,[r4,#ex38]
= = o-n--o 0x000529DC VMUL.F32 52,50,53
Console = 0x000529E0 VMUL.F32 s3,s1,s3
No consoles to display at this time. ©x000529E4 cMP re,#o
0x000529E8 VMLA.F32 s2,s1,515
0x000529EC VMLS.F32 $3,50,515
0x000529F0 VSTR $2,[r11,#-0x10]
©x000529F4 VSTR $3,[r11,#-0x14] o
< >

Copyright © 2021 Arm Limited (or its affiliates). All rights reserved.
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7 Example - How to analyze the
sample capture

In the Timeline view, you can see a timeline with information such as CPU activity, branch
mispredictions, and instructions executed. You can click the timeline to set a cross-section
market at 1.75 seconds of execution. That point in the execution time corresponds to one of the
activity peaks in the Cortex-A7 core.

In the heat map below, you can see the CPU activity for the different processes. At 1.75s, you
notice that the xaos #2750 process is in orange color, using 36.37% of the CPU Activity.

# Start | 14 Linux - TC2 - Xaos # =g ‘
B Timeline| # Call Paths| ® Functions ki Code ¥ Log
B n wve @ soms - 1.755/(10.783s M- 8a®

1s |

.75s[o.05§1‘ 255 3
PR

s 3.5s 4s 4.5s 5s 5.5s 6s 6.5s 7s 7.5s 8s 8.5s 9s 9.1
OO OO TR |

©0.00%
©0.00%

4

0s 0.5s d

0

» CPU Activity (Cortex-A15) i
@ User

@ System

» CPU Activity (Cortex-A7) i
©User A
@ System B
» Branch (Cortex-A15) i
© Mispredicted
> Branch (Cortex-A7) L
©Mispredicted
> Bus (Cortex-A15) i
@ Access
> Cache (Cortex-A15) #w
@12 data access
» Cache (Cortex-A7) *

©L2 data access
- B ydloIu L 10L
» Ixsession #2356
»1 menu-cached #2468
> rsyslogd #1369
»1 ssh-agent #2399
>+ xaos #2750 A
i Xorg #2192
WHeat Map [H] ¥ Row Filter Annotation Filter

Go to the Call Paths view selecting the Call Paths tab. The main code is contained within

the xaos #2750 process and thread. We want to see which functions in main are using more
resources. If you click main, you can see that more than half of the samples (52.81%)

inmain correspond to the function VisualAnnotateImage. That correspondstoa 11.11%
of samples inthe xaos #2750 process.
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|4 Start | Linux - TC2 - Xaos | s
B Timeline| # Call Paths| @ Functions§ & Code| & Log‘
® @ & Row Filter [ 0(0.00%)| & ®
[Process]/{Thread}/Code Total: Samples (#/%) '.‘ Self: Samples (#/%) | % Process: Samples | Stack \ Location
2 idle 38354 73109% - A
=0 idle 38354 73109% 100.00%
~ & <unknown code in kernel> 38,325 1 _ 38,325 _ _ 0
& <unknown code in gator> 29 0.06% 29 0.08% 0.08% 0 -
2 + xaos #2750 6,596 12.57%
| #© xaos #2750 3315 6.32% 50.26% 5
- & <unknown code in kernel> 1,418 1,418 :21.50% . 21.50% 0 -
= @ main_loop 1385 2.64% 0 0.00% 21.00% 56 ui.c:1724
= e ui_updatestatus 734 1.40% 0 0.00% 11.13% 92 ui.c:360
© VisualAnnotatelmage 733 1.40% 732 11.10% | 11.11% 128 annotate.c:148
© addBmpHeader 1 <0.01% 1 0.02% 0.02% 164 annotate.c:84
© uih_drawwindows 1 <0.01% 0 0.00% 0.02% 128 wstack.c:339
© getpos 1 <0.01% 1 0.02% 0.02% 152 messg.c:18
= @ uih_do_fractal 631 1.20% 0 0.00% 9.57% 88 ui_helper.c:912
© do_fractal 568 1.08% 0 0.00% 8.61% 124 zoom.c:1575
= o calculatenewinterruptible 509 0.97% 5 0.08% | 1.72% 160 zoom.c:1382
= @ processqueue 421 0.80% 1 0.02% 6.38% 196 zoom.c:1334
% o calccolumn_32 234 0.45% 1 0.02% 3.55% 240 zoomd.c:145
= @ calculate 232 0.44% 105 1.59% 3.52% 256 calculate.h:5 Vi
Function Name ‘Samples (#/%) f‘ Instances ‘ Location
* VisualAnnotatelmage 732 B81% annotate.c:148 A
@ calculate 285 [ 20.56% 4 calculate.h:5
© mand_calc 122 | 8.80% 2 xaos
© mkrealloc_table 50| 3.61% 1 zoom.c:457
@ calccolumn_32 40 | 2.89% 2 zoomd.c:145
o fillline_32 40 | 2.89% 1 zoomd.c:296
o calcline_32 30| 2.16% 2 zoomd.c:39
© look132 13| 0.94% 2 autod.c:4 v
Now, select the Functions tab to see the Functions view. You can see that the
function VisualAnnotateImage appears at the top and that it is one of the functions with
the highest number of samples. Double-click the function to open the Code view for
the VisualAnnotateImage function.
'-!'Start‘ 1 Linux - TC2 - Xaos & ‘ e
M Timeline| # Call Paths| @ Functions‘ & Codel@ Logl
b 5| Row Filter |\70\ -la®
Function Name ‘Self: Samples (#/%) '1 Total: Samples (#/%) \ Instances \ Stack ‘ Size | Location ‘ Image ‘
& <unknown code in kernel> 47,322 47,322 _ 23 0 - |- - A
@ calculate 1,462 2.79% 2,999 5.72% 21 16 240 calculate.h:5 Xaos
@ VisualAnnotatelmage 732 139% 733 1.40% 1 36 424 annotate.c:148 Xaos
& <unknown code in libc-2.17.s0> 723 1.38% 723 1.38% 7 0 Sl =
@ mand_calc 592 1.13% 592 1.13% 10 16 804 xaos Xaos
& <unknown code in libpixman-1.50.0.28.2> 485 0.92% 485 0.92% 2 0 Silis =
@ fillline_32 246 0.47% 246 0.47% 9 4 124 zoomd.c:296 Xaos
@ calccolumn_32 175 0.33% 1,376 2.62% 10 44 984 zoomd.c:145 Xaos
@ calcline_32 107 0.20% 1,007 1.92% 10 44 932 zoomd.c:39 Xaos
@ mkrealloc_table 85 0.16% 85 0.16% 5 52 2,704 zoom.c:457 Xaos
@ moveoldpoints 79 0.15% 79 0.15% 5 40 244 zoom.c:954 Xaos
© mand_peri 48 0.09% 48 0.09% 11 16 1,236 xaos Xaos
@ plt [xaos] 46 0.09% 46 0.09% 5 0 2,456 xaos Xaos
© _aeabi_uidivmod 39 0.07% 39 0.07% 5 0 28 xaos Xaos

One of the advantages of Streamline is that you can obtain a performance analysis from a high
level and general perspective to the lowest level possible. In this example, we began detecting
one of the processes with the highest CPU activity. Then, we detected one of the functions with
more samples, within the main code that is executed in that process. Now, we can reach the
lowest level possible, which is detecting which instructions are executed more frequently.

In the Code view, you see the code for the VisualAnnotateImage function, whichis
included in annotate. c. Select the highlighted icon in the following image to also show the
assembly code:
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Example - How to analyze the sample capture

% Start| & Linux - TC2 - Xaos | _
B Timeline | # Call Paths ‘ @ Functions & Code|
e @~ & 4 | Find

The code inline 174 (for loop) corresponds to the 49.04% of the samples in the function. If
you click the line 174, you can see the associated assembly code in green. You have been able to
locate the instructions that are constantly executed in your code. This procedure can help you
detecting bottlenecks in your code. The instruction ADD r2, r2, #3 corresponds to the
30.05% of the samples in the VisualAnnotateImage function.

| Start | & Linux - TC2 - Xaos | =D
.Txmeline!afCall Paths!@ Functions | & Code%@’ Logf
@& 4 | Find IC B 359 (0.68%)| @
Self: Samples (#/%)‘ I LineiSource File: C:/Users, '/Development Studio Workspace/xaos/xaos-3.5/src/ui/ui-drv/gtk/annotate.c ~
170 // Copy (and invert) the Xaos fractal screen data in CAIRO_FORMAT_RGB24 (32 bit) format

171 // to the visual annotation bmp buffer in 24 bit format
172 for (row = bmp_height-1; row >= @; row--) {

173 screen_row_start = row * bmp _width * 4;
359 | 490e4% | 174
93 12.70% 175 buffer[offset++] = screen_data[screen_row_start++]; // b
138  18.85% 176 buffer[offset++] = screen_data[screen_row_start++]; // g
80 10.93% 177 buffer[offset++] = screen_data[screen_row_start++]; // r
178
179 // discard unused upper (A) byte, but set to opaque for the Screen Viewer
62 8.47% 180 screen_data[screen_row_start++] = OxFF;
181 }
182 memcpy (&buffer[offset], pad, bmp_pad_bytes);
183 offset += bmp_pad_bytes;
184 i
185
186 ANNOTATE_VISUAL (buffer, bmp_file_size, "Xaos"); v
107 £, Lbubs. A
Self: Samples #/%)| || Address ‘ Opcode |Disassembly ~
0x00066974 ADD r2,r5,rd4
0x00066978 MoV ri,#e
45 6.15% 0x0006697C - - LDRB re,[r3,#e]
1] e.14% ADD ri,ri,#1
220 30.05%  Ox00066984 ADD r2,r2,#3
0x00066988 ADD r3,r3,#
48 | 6.56% ©x0006698C - ' -0004 STRB re,[r5,r4]
©x00066990 - ADD r4,r4,#3
92 12.57% 0x00066994 LDRB re,[r3,#-3]
46 6.28% 0x00066998 - 2002 STRB re,[r2,#-2]
41 5.60% 0x0006699C ~-5-0007 LDRB re,[r3,#-2]
39 5.33% OX000669A0 © - STRB re,[r2,#-1]
62 8.47% ©X00O669A4 © - STRB r7,[r3,#-1]
41 5.60% ©Xx000669A8 LDR re,[ré,#o0]
97 | 13.25% ©x000669AC cMP re,rl
0x000669B0 BGT {pc}-0x34 ; Ox6697c >
Ae.AnnsrARa - e Zn Ten una
< >
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Add the project path to Streamline locations

s Add the project path to
Streamline locations

If you generate and save your own Streamline reports in a project, you must include the
location of the reports. You must indicate the path to the folders with the captures you want to
analyze, so Streamline can find the captures in your file system.

As an example, in case you created and saved reports in your Xaos project:
1. In Streamline, click Window > Preferences.

2. Toadd or remove locations where Streamline analysis data can be found, select Data
Locations.

3. Click New and select the Streamline folder with captures within the xaos project folder
in your workspace. Then click Apply and close.

4. Your captures are now listed in the Streamline Data view.
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